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Creating a Poster Using MS Excel 
 
1. Start MS Excel program.  
2. In the “View” Menu scroll to 

“Toolbars,” and then make sure there are 
check marks in front of “Standard” and 
“Formatting.”  If not, please do so by 

click on it.  
3. Your toolbars may have opened in a 

clumsy place on your screen.  If so, 
place the cursor on the shaded bar at the 
top of the toolbar and hold down the 
mouse button to drag it.  Drag the 
toolbar upward until you hear a click.  
The new toolbar is now grouped with the 
rest of the toolbars at the top of the 
screen. 

 
4. Click in the rectangle in the upper, left-

hand corner (left of cell “A” and above 
cell “1”) of the spreadsheet to select the 
entire spreadsheet. 

 

5. Hold down the mouse button on the 
triangle next to the font size and select 
24. 

 
6. Click once on cell C3 to select it. 
 
7. Type “Wonderful!” and press the Enter 

key. 

 
 
8. Hold down the mouse button on cell A1 

and drag the cursor to cell E1 to select 
all those cells and then let go the mouse 
button (do not click any where else). 

 
9. Hold down mouse button on the triangle 

next to the paint bucket icon and drag 
the cursor to the red color box and let go 
the mouse button. 

 
10. Hold down the mouse button on cell A5 

and drag to E5 to select all those cells.  
Let go. 

 
11. Click on the paint bucket icon.  Red is 

still selected! 
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12. Select cells A2 to A4.  Click on paint 
bucket icon.  Red is still selected! 

 
13. Select E2 to E4.  Click the pain bucket 

icon.  Red is still selected! 
 
14. Select B2 to D2.  Click on the triangle 

next to the paint bucket and drag down 
to select blue.  Let go. 

 
15. Select B4 to D4.  Click the paint bucket 

icon.  Blue is still selected! 
 
16. Select B3.  Select the pain bucket icon.  

Blue is still selected! 
 
17. Select D3.  Click the paint bucket icon.  

Blue is still selected! 
 
18. In the column heading, place your cursor 

directly on the line that separates column 
C and column D.  (Note: your cursor 
turns into a two-way arrow.) 

 

 
19. Hold down the mouse button and drag 

the two-way arrow to the right to expand 
the width of the column C so that the 
words “Wonderful!” fit in the column.  
Let go. 

 
20. Click anywhere on the spreadsheet to 

clear the highlight and view your poster. 
21. In the row heading marked with numbers, 

click on the number “1” to select that 
row. 

 
22. Click “Insert” and then “rows” to insert 

a row above row 1. 
 
23. In the column heading, click on “A” to 

select that column. 
 
24. Click “Insert” and then “columns” to 

insert a column to the left of column 
“A.” 

 
25. Select columns B and C by dragging 

across them.  Let go.  Then, hold down 
the “  (apple)” key (PC you press 
“Ctrl” key) as you drag cross columns E 
and F.  Let go.  All four columns should 
be highlighted.   

 
26. In the column heading, put the cursor 

over the line to the right of any selected 
column.  Drag the two-way arrow to the 
left to make all selected columns 
narrower.  Let go. 

 
27. Click anywhere on the sheet to remove 

the highlights from the columns and 
view your poster. 
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Drawing Using any MS Office Programs 
 

1. Click on the Drawing button to select the drawing tools. 

 
2. Note that the Drawing Toolbar appears at the left of your screen.  Note that 

when you rest the cursor on a drawing tool for a few seconds, a little box and 
explanation for that tool appears.  Before going on, spend some time 
experimenting with the drawing tools (see the picture on the right). 

3. Create your won landscape drawing using skills from the previous lesson and 
the Drawing Toolbar.  The sample below shows how each of the effects was 
achieved. 

 
4. Create blue background by selecting 

cells A1 to E15.  Select a “Fill Color” 
from the “Paint Bucket.”  

5. Create the sun by selecting the oval tool 
(which is in the AutoShapes) and 
dragging.  Select a Fill Color from the 
“Paint bucket.” 

 

6. Create trees and cloud by selecting the 
Lines – Freeform tool.  Hold down 
button to draw irregular lines.  Click to 
start and stop straight lines.  Double-
click to end drawing.  Select a color 
from “Paint Bucket.” 

 
7. Add a text box by selecting the Text Box 

tool.  Type your text in the box.  Select 
“No Fill” in the Paint Bucket tool if you 
want the colors of the picture to show 
through the text box.  DO MORE 
STUFF! 
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Printing MS Excel 
 
The following “Page Setup” guidelines will 
adjust the Spreadsheet (Excel) to print 
everything in a single page.  It will also make 
automatic horizontal and vertical center 
adjustments.   
 
1. Click the “File” and then click “Page 

Setup.” 
2. You will see a new “Page Setup” window 

like the one below.  If you get a new 
window but not exactly same window as 
the one below, click on the “Page” tab 
within the “Page Setup” window. 

 

 
 
3. Click on the circle that is in front of the 

“Fit to” so that it will look like the picture 
above.  Also, make sure that the number 
of page is “1.” 

 
4. Click on the “Margins” Tab within the 

“Page Setup” window.  You will see a 
window like the one below.  Change all 
the numbers to “0” like the picture below. 

 
 
 
 
 
 
 

 
 
 

 
 
5. Now click on the both of the square boxes 

at the bottom and in front of words 
“horizontally” and “vertically.”  It will 
create a check mark in the square box. 

 
6. Click OK.   
 
7. Now you are ready to print. 
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Creating Grid Papers 
 

INTRODUCTION:  Spreadsheets can provide 
powerful support for mathematics instruction.  
Many materials and teaching strategies are 
most directly and efficiently developed using 
spreadsheet formats rather than a word 
process. 
 
Spreadsheet formats are rarely used by 
teachers because spreadsheets were originally 
designed with business accounting in mind 
and all instructional manual available today 
emphasize those types of tasks.  Most teachers 
have never really had the opportunity to 
develop spreadsheet skills that are relevant to 
instructional needs. 
 
Consequently, it is not unusual to find 
teachers struggling with a word processor 
trying to develop supportive materials that just 
don’t fit a word processor.  Word processors 
are very good at word-wrapping and 
paragraph formatting, but if you want a quick, 
practical quality way of developing materials 
that support mathematics instruction (e.g., 
measurement, problem solving and geometry) 
the spreadsheet will do much better job. 
 
The examples given here will illustrate how 
spreadsheets can be used with mathematics 
instruction in three ways: 
 
1. as a practical means for developing high-

quality grid papers of all types. 
a. multi-purpose inch-grids for primary 

children 
b. multi-purpose centimeter-grids for 

intermediate and secondary children 
c. a wide variety of special-purpose grids 

for specific math topics 
 
2. as a practical means for creating graphics 

of concrete manipulative for instructional 
activities, for example: 

a. connecting cubes and inch blocks 
for primary grades 

b. base ten blocks for primary and 
intermediate grades 

c. centimeter rods (Cuisenaire rods) 
for intermediate and secondary 
grads. 

 
3. for creating special problem-solving 

formats in which children make an 
organized list, draw a picture, estimate 
an answer from a draw a picture, 
estimate an answer from a drawing, 
manipulate shapes by moving them 
around into different configurations, 
and other strategies for solving a 
problem. 

 
SET-UP INSTRUCTIONS: Before you 
begin to construct any of the samples, 
make the changes on the Page Setup so 
that your spreadsheet will print out 
correctly. 
 
In the “File” Menu select “Page Setup…” 

 
 
In the Page Setup Window, make the 
following choices: 
 
In the Page folder 

Orientation select: Portrait 
Scaling select:   Fit to 1 page 
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In the Margin folder 
Top  select .6 
Bottom  select .5 
Left  select .4 
Right  select .4 
Header  select .6 
Footer  select .6 

 
In the Sheet folder 

Make sure Gridlines is not selected.  That 
way you will see the gridlines as you work 
on the spreadsheet, but they will not print 
out. 
 

I.  Creating Grid Papers 
 
1.  Inch-grid for primary children. 
 
a) Click on the small, gray rectangle in the 

upper, left-hand corner (left of column 
“A” and above row “1”).  That will select 
the entire worksheet. 

b) In the “Format” menu, select “Column-
Width”, type “9.86” and then click “OK.”  
All columns are now 1-inch wide. 

c) In the Format menu, select “Row-Height,” 
type “66” and click “OK.”  All rows are 
now 1-inch high. 

d) Click on cell A1 to select it.  
Use the Border Tool to select a 
border for the cell. 

e) Copy cell A1.  Paste it on B1 to G1 
f) Copy cells A1 to G1.  Past it on cells A2 

to A9. 
 

 

 
2.  Centimeter-grids for intermediate and 

secondary children.  Follow the same 
procedure as described for inch-grids 
with the following changes: 

 
• Make the column width 3.29 
• Make the row height 25 
• After adding border to A1, paste it on 

cells B1 to S1 
• Copy cells A1 to S1. Paste them to 

cells A2 to A25. 

 
 
3.  Inch-Dot-Grids (Geoboard grid) for 

primary and intermediate grades.  Use 
the inch-grid spreadsheet and make the 
following changes: 

 
a) Click on the gray rectangle in the 

upper, left-hand corner.  That will 
select the entire worksheet. 

b) Drag on the “Border” tool to 
select no borders.  All borders are now 
gone. 

c) Use the Font buttons to drag and select 
“Palatino” and “14” point font. 

d) Click on cell A1 to select it.  
Type a period (“.”). 

e) Click on the center justify icon 
f) Copy cell A1 to the same cells as you 

did when making inch-grids.  (see 
above 

 



 

Lim  EDTE330A  

32

 
 
4.  Centimeter Dot Grids for intermediate and 

secondary grades.  Use the centimeter-grid 
spreadsheet and make the following 
changes: 

 
• Click on the gray rectangle in the upper, 

left-hand corner.  That will select the 
entire worksheet. 

• Drag on the “Border” tool to select no 
border.  All borders are now gone. 

• Use the Font buttons to drag and select 
“Palatino” and “10” point font. 

• Click on cell A1 to select it.  Type a period 
(“.”). 

• Copy cell A1 to the same cells as you did 
when making centimeter-grids.  (see 
above) 

 
II.  Creating Graphics of Concrete 

Manipulative 
 
1. Primary Sample:  Addition with inch 

cubes or connecting cubes (Unifix Cubes).  
Use the inch grid spreadsheet and make 
the following changes: 

 
a) Remove all borders just as you did when 

you made dot-grids. 
b) Format the entire sheet for Palatino 48 

point font. 
c) Type a number sentence “2+3=?” 
d) Use the Border and Pain Bucket tools to 

make a complementary graphic in the cells 
below the number sentence. 

 
 
2. Intermediate/Secondary Sample #1:  

Addition with centimeter rods 
(Cuisenaire rods) or base ten blocks.  
Use the centimeter grid spreadsheet 
and make the following changes: 

 
a) Remove all borders just as you did 

when you made dot-grids. 
b) Format the entire sheet for Palatino 18 

point font. 
c) Type an addition problem as shown 

below.  (NOTE: I have placed one 
numeral in each cell – helps kids keep 
things lined up and make the typing 
simple.  ALSO: When you type the 
“+” sign, you must precede it with a 
single quote symbol (‘).  That way, the 
computer knows you do not intend to 
write an equation and will not treat the 
plus sign as the start of an equation.  
The same is true for other operational 
symbols like subtract (-), multiply (*), 
divide (/), less than (<), greater than 
(>), and equals (=).  When you precede 
these with a single quote symbol (‘), 
the quote symbol will not show on the 
spreadsheet! 

d) Use the Border, Paint Bucket, Copy 
and Paste tools to make 
complementary graphics in the cells 
near the problem.  Children can cut out 
the graphics and paste them together as 
they work the problem, or draw the 
answer elsewhere on the page. 
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3. Intermediate/Secondary Sample #2:  

Subtraction with centimeter rods or base 
10 blocks.  Use the centimeter grid 
spreadsheet, clear it of borders and change 
the font setting to Palatino 18 point just as 
you did for Sample #1 above.  Or, you can 
start with Sample #1, clear it of borders, 
patterns and texts, and make the following 
changes: 

 
a) Select a 10-by-10 cell area to one side for 

children to draw answers.  Drag over the 
area to select it.  Note:  The Border tool 
does not permit you to select a dotted line, 
but the “Format” menu does. 

 
b) In the Format menu select Cells.  Then 

select the Border folder and make the 
following choices: 

1. dotted line button under Style 
2. drag to the color blue in the color 

menu 
3. do this last: under Border click on the 

Left, Right, Top and Bottom buttons. 
c) If you choose to shade in the first 

number of the problem on the grid, use 
the “Paint Can” to select a light color 
or light-gray so kids can easily draw 
over it.  I chose very light blue.  Since 
this handout is printed black and white, 
it comes out a light shade or gray. 

d) After setting up one problem, use 
Copy and Paste to place it in all the 
other problem positions to save time.  
Then edit each problem to make it 
different.  (I did not do the last step in 
my sample.)  Don’t forget to enter the 
single quote symbol (’) before typing a 
plus (+) or minus (-) sign. 
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Formatting in MS Excel 
 

Another useful way of utilizing MS Excel is 
to use the Spreadsheet tools to enhance the 
worksheets as well as classroom 
management. 
 
I.  Sample Science Worksheet 
 
1. Type in the labels for your chart.  And 

then, use the formatting buttons to Bold 
and Center 
text.  

 

 
 
2. Hold down the mouse button 

on the triangle next to the 
Borders tool to select borders 
for your chart. 

 
 

3. Click the cell C8.  Type an equation to 
average numbers in that column by 
typing “=average(C3:C7).”  Note:  You 
must type in the column letters and row 
numbers correct for your chart, but the 
rest of the equation shown in the sample 
will be the same.  Click “Enter.”  Some 
garbage appears in the cell.  That’s OK. 

 

 
 

4. Type in the numbers 1 
to 5 in the cells directly 
under “Trial 1.”  The 
correct average, 3, 
should appear on cell 
C8. 

 
5. You will now fill the same the equation 

to the bottom of all the other columns by 
clicking the cell C8 through G8 and then 
click “Edit” menu, “Fill” and then select 
“Right.”  When you do this, the MS 
Excel will automatically change the 
formula to appropriate cell names (i.e., 
=average(C3:C7) will change to 
=average(D3:D7) in column D8). 

 
6. At first, some more garbage may appear 

at the bottom of the columns.  Ignore it.  
Now type more numbers into the empty 
cells to test your equations. 

 
 

7. Now you will make a chart which shows 
the title and numbers that appear in the 
“Average” row of your chart.  Select cell 
C8 to G8 by dragging the cursor across 
them. 

8. Click on the Chart Wizard tool.   
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9. Follow the “Chart Wizard” directions 
and make any changes you wish.  Click 
“Next”  

 
10. When you done, click “Finish.” The 

chart appears. 

 
 

11. Change the values of any numbers and 
watch the averages cells and chart 
change as you change the values.  You 
can double-click on the chart to select it, 
and then double-click on any part of the 
chart to see an editing window for that 
part.  Take some time to explore the 
editing windows. 

 
 
12. Try making your own form for science 

lessons.  How could you format a 
spreadsheet that helps children learn 
how to control variables?  Observe?  
Classify things?  Form good hypotheses?  
Make charts of their observations?  
Compare similarities and differences?  
Operationalize definitions?  Plan ways to 

test a guess?  Plan a project for a science 
fair? 

 
13. Can you think of similar strategies for 

social studies lessons?  Classroom 
management such as grade book? 

 
II.  Most Commonly Used MS Excel 

Functions by Teachers. 
 
The following information has to be typed in 
the formula bar (or in the cell).  If you don’t 
see the formula bar, click “View” and then 
“Formula Bar.” 
 
1. =average(C3:C9)  This will return the 

average (arithmetic mean) in a range of 
cells C3 to C9. 

2. =sum(C3:C9)  Add all numbers in a 
range of cells C3 to C9. 

3. Getting the letter grade (using “Lookup 
Table” command) is little more 
complicated.  Follow the steps below. 

a) We can ask Excel to look at the 
numerical average in one column (I am 
using the column “M” as an example) 
and compare it to a list which defines the 
grading scale, for the purpose of 
assigning a letter grade to the average 
(on column “N”).  

b) First you need to create a table some 
where within the work area (I am using 
cells A1 to B5). 

c) The information to the left, 
defining the grade scale 
must be entered in 
ascending order from top to 
bottom. The number 
entered to the left of a letter must be the 
lowest number grade that would equal 
that letter grade. 

d) Highlight the entire range from A1 to B5. 
e) Go to the Insert menu, select Name and 

choose Define. 
f) Give a name to this lookup table; I called 

mine “grades.” 
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g) Next write an equation which will look 
at a student’s numerical average, look at 

a list of grades, and assign a letter grade 
to the student. This is done with a  

functioned named VLOOKUP. The 
equation must specify three elements: 

i. The location of the numerical grade to 
be compared (M7 in the example). 

ii. The name of the lookup table (mine was 
named “grades”). 

iii. The location of the letter grade in the 
lookup table (2) 

 
h) After the equation is entered in N7, click 

and highlight the cells including cell N7 
and then use the “Fill” tool (see #5 on 
page 34) to fill the equation down into 
remainder of the grade book cells. 

 
4. If you want to see all possible function 

in MS Excel, click on the little triangle 
next to the ∑ icon on the menu bar and 
then select “More Functions…”  This 
will show all the functions you will ever 
need using MS Excel. 

 
III.  Formatting Data (decimal places) 
 
Averages can be displayed to whatever 
precision you wish to use. I used one 
decimal place, although you may wish to use 
zero decimal places. Zero decimal places 
would keep the grades in a format like they 
are reported to students. An advantage of 
using zero decimal places would be to avoid 
confusion regarding rounding grades. To 

illustrate this consider the following grade: 
A grade of 75.49 would round to 75 with 
zero decimal places. However, at one 
decimal place that grade rounds to 75.5 and 
students would have the expectation that the 
grade would round to 76. Using zero 
decimal places will allow Excel to round 
without confusion to some students.  
How to Format 
1. Highlight the column to be formatted by 

clicking on the letter at the top of the 
column. 

2. From the Format menu choose Cells 
3. From the Format Cells window choose 

Number and then select the number of 
decimal place you want to use. 

 

Spreadsheet Project 

1. Create two totally different worksheets 
or handouts of your choice.  Please do 
not make all simple ones.  See the 
samples.  At least one worksheet should 
include graph(s). 

2. Create one grade book or classroom 
management form.  You need to use the 
formulas to do the auto-calculations 
including the letter grades.  Please input 
at least ten student names and at least 
five data such as test scores or 
homework assignments. 

3. Save the files in your folder in the 
sharedrive and in your personal disk for 
the back-up. 

4. Print all three files. Write your name on 
all three handouts and turn them in to the 
instructor. 
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Sample Classroom Management Forms 
 

1. Weekly Lesson Plan Forms 

 
2. PQR Testing Record Keeping Form 

 
3. Field Trip Organization Sheet 
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Creating Newsletter and Resume Using MS Word 
 
We will be using Microsoft Word to create 
the Newsletters.  Microsoft Word is the 
word processing component of the 
Microsoft Office suite.  In many ways, 
Word is the electronic typewriter of the 
computer, but it has many features than a 
typewriter. 
 
Starting the Microsoft Word 

 
1. Start the Microsoft Word. 
2. Make sure you have the Standard and 

Formatting tool menus on the window.  
In order to check this, click “View” and 
then “Toolbars.”  You should have a 
“check” in front of “Standard” and 
“Formatting.”  (See below) 

 

 
 
About different Tools 
 
When you move the cursor 
on top of the buttons 
(icons), it will show the 
name of the button.  See 
example on the right. 
 

Here are some of the most commonly used 
buttons while creating a document.  
 
1. Open a Word document. 
 
2. Save the current document. 
 
3. Print the current document 
 
4. Change the font style 
 
5. Check Spelling and Grammar 
 
6. Change font size 
 
7. Change font style (bold, italic, and 

underline) 
 
8. Insert Hyperlink 
 
9. Justify the paragraph 
 
10. Insert Tables 
 
11. Create documents in columns (e.g., this 

page has two columns) 
 
12. Auto bullet and number  
 
13. Highlight the text 
 
14. Change the text color 
 

 
 
 

1 2 3 4 5 6 7 8 9 10 11 12 13 14
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Inserting Table 
 
1. Click on “Table” and then “Insert.”  

Select “Table.”  You will a new window 
(see below). 

 
2. Change the number of columns and rows 

you want and then click “OK.” 
 
Inserting Clip Arts and Pictures from 
your file 
 
1. Click “Insert” and then “Picture.”  Select 

“Clip Art.” 
2. Select the clip art of your choice and 

then click “OK.” 
3. If you want to insert your own picture or 

clip art, click select “From File…” 
instead of “Clip Art.” 

4. Navigate the folder system to find the 
clip art or picture of your choice.  And 
then click “OK.” 

 
Cropping your clip arts or pictures 
 
1. Click on the picture you will see a 

floating toolbar looks similar to the one 
below. 

 
2. If you don’t see it, click on “View” and 

then “Toolbars.”  Select “Picture.” 

3. Click on the  icon. 
 
4. Click on one of the small square dots 

around the picture (pick the side you 
want to crop). 

5. Click and drag toward inside of the 
picture and when you reach the area you 
want to crop, let go the mouse. 

 
Creating columns 
 
1. Highlight the text and pictures you want 

to create columns. 
2. Click on the “Column” button (see #11 

on previous page). 
3. Select the number of the columns you 

want.  The example below, I have 
selected three columns. 

 
4. Your text will be reformatting with 

columns. 
 
Inserting Hyperlink 
 
1. Type in the text that you want displayed 

as the hyperlink by clicking in the text 
(highlight the text you want to 
hyperlink). 

2. Click on the “Insert Hyperlink” button 
(see #8 on the previous page). 
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3. Type in the URL next to “Address.” 
4. After clicking “OK,” the text appears on 

the page underlined in blue.  To test the 
link, you must be connected to the 
Internet.  Hold down the “Ctrl” key on 
the keyboard and click the hyperlink. 

 
Setting Background Effects 

 
When you use the “fancy” backgrounds, you 
won’t be able to print the file with the 
backgrounds.  However, the backgrounds 
can be viewed on the web pages.  So please 
Click “View” and select the view choice you 
desire (e.g., for normal typing use “Normal,” 
for print view use “Print Layout,” and for 
web view use “Web Layout”). 
 
1. To set back ground effects on the page, 

select Background from the Format 
menu. 

 
2. From the Background options, select Fill 

Effects, then select the Texture tab.  

Select one of the textures (a light 
background is preferred for printing 
purposes by clicking on it and then click 
“OK.” 

 
 

Newsletter Project 
 
1. Create a Newsletter for your class and a 

resume for your future employment.  
(Visit the web site to see the samples. 
http://www.csus.edu/indiv/l/limb/courses
/edte330ar.htm). 

2. Use all the tools on previous two pages 
(i.e., tables, clip arts, columns, 
hyperlinks, and background effects) on 
your newsletter. 

3. You don’t have to use all the tools on 
your resume. 

4. Save the newsletter file and the resume 
file in your folder in the sharedrive.  
Also, save a back-up copy in your floppy 
disk. 

5. Turn in the hard copies to the instructor 
6. You will eventually post this resume and 

the newsletter on your web site. 
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Instructional Strategies for Educational Digital Media 
 
Introduction: Instructional strategies used 
for educational software are the same as 
those used by teachers everywhere.  
Depending on the content, an instructional 
strategy may work particularly well with a 
computer – taking advantage of the 
computers peculiar strengths.  In other 
instances a teaching strategy might actually 
work better WITHOUT a computer.  
Following are some examples of the major 
teaching strategies used by teachers and 
computers. 
 
Searches 

Children use “search 
engines” in references to 
find answers.  The most 
engaging use of references 
begins with a problem to 

solve rather than a “topic” to look up – see 
Problem Solving.  Examples:  Grolier’s 
Interactive Encyclopedia, How Things Work, 
Musical Instruments, Atlas 3-D, Animals! 
2.0, Dinosaurs, Encarta 96, Mammals: A 
Multimedia Encyclopedia, and many, many 
more. 
 
Drill & Practice 

Children practice skills 
and their level of skill 
attainment is assessed.  
Examples:  Page-turner 
practice reading 
programs like Arthur’s 
Teacher Troubles, Just 

Grandma & Me, Imo & the King, Baba 
Yaga & the Magic Geese, Harry & the 
Haunted House, Little Monster at School, 
Little Samurai and skills-centered programs 
like A to Zap!, First Phonics, Graph Club, 
Jumpstart Kindergarten, Kid Phonics, 
Supersonic Phonics, Math Rabbit, Math 
Town, Math Workshop and Sticky Bear’s 
Reading Room. 

Tutoring 
New concepts and/or skills are presented, 

practiced and assessed.  
Example: Kid keys, Kid 
Phonics, Ultra Key Typing 
Tutor. 
 
 

 
Problem Solving 

Children use critical 
thinking strategies to 
solve problem – 
mistakes are viewed as 
learning opportunities 
– knowledge & skills 
are refined through 

application.  Examples:  Set-up problem 
solving situation like Oregon Trail, and 
developing answers to interesting problems 
by using references like those mentioned 
earlier. 
 
Simulation 

This is a virtual reality 
which imitates the real 
world.  These are 
experiences not easily 
provided in the classroom 
or often experienced in 
life.  Developed correctly, 
simulation can be the 
most powerful strategy 

employed in educational software because 
simulation is a particular strength for 
computers.  Students control what happens 
and observe the consequences of their 
decisions.  (Want to play Global Thermo-
Nuclear War?) Examples: Sim City, Oregon 
Trail, A.D.A.M. the Inside Story, How Your 
Body Works, the Way Things Work and 
“field trip” simulations of which there are 
several examples in the lab. 
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Evaluating the software 
 
1. Software Organization in the Green 

Cabinet:  
You will need to get a CD-ROM from the 
green cabinet to evaluate the software.  The 
CDs are stored in cardboard boxes or plastic 
CD cases.  They are stored in alphabetical 
order according to their titles and using the 
common convention of dropping 
unimportant words at the beginning of titles 
like “The…” or “A…”  so, a CD entitled 
“The Wonderful World of Animals” will be 
filed under “W.” 
 
2. Checking Out Software:  
Use the name card you created when you 
took the picture (if you don’t have it 
anymore, make one).  Insert it in the exact 
place where you found your software on the 
shelves of the green cabinet.  When you 
return the software to its same location at the 
end of class, you should retrieve your name 
card.  
 
 
 
 
 
 

 

3.  Suggestions:   
The software stored in the lab is composed 
mostly of those programs found most useful 
by public school teachers and the faculty 
who teach in the lab – though we have kept 
a few examples of software for the sake of 
their flaws.  The software cabinet will be 
unlocked during class time only for a few 
classes so that you can review the software 
stored there.  You should take advantage of 
the opportunity and review as much of the 
software as you can.  Once you begin 
developing specific projects with the 
software, there is usually no much 
opportunity to review. 
  
Educational Digital Media Project 

 
You may work with other classmates but 
you are responsible for your own write ups. 
 
1. Evaluate two software (one reference 

tool software and one technology 
assisted instructional software). 

 
2. Fill out the forms on pages 43-46 of the 

handout and turn them into the instructor.  

 


